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Recent studies have examined the relationship 
between inadequate blood levels of Vitamin D 
and diseases such as cancer, heart disease, 
Alzheimer’s disease and diabetes. While it is 
agreed that the ―sunshine vitamin‖ is essential 
for bone health and other health functions, no 
causal relationship has been 
established between these dis-
eases and Vitamin D levels. 
 
―Anyone taking Vitamin D sup-
plements should be aware of 
the emerging facts and new 
recommendations,‖ says Elaine 
Abrams MPH, RN, Community Health Coordi-
nator at Visiting Nurse & Hospice of Fairfield 
County. ―Right now, a lack of consensus in the 
research community has resulted in confusion 
and conflicting advice.‖ 
 
Abrams will present ―Vitamin D: What You 
Should Know‖ on Wednesday, April 27 at 
12:45 p.m. at Ogden House.  She will discuss 
recent changes in daily intake reference val-
ues for Vitamin D, measuring Vitamin D in the 
blood, groups at risk for deficiency, health 
risks from excessive Vitamin D, and important 
dietary sources. 
 
How much vitamin D should I take? 
The Institute of Medicine, which sets recom-
mended daily levels for nutrients, released 
new 2010 guidelines noting that healthy adults 
over age 70 need 800 IU daily of Vitamin D 
through diet and/or supplements to maintain 
bone health. This represents an increase over 
previously recommended levels of 200-600 IU 
daily.  However, you should discuss your ade-
quate vitamin D intake with your physician. A 
blood test that measures one’s vitamin D level 
is  now widely available. 
 

Can too much vitamin D (via supplements) 
cause problems? 
Vitamin D can be toxic in high doses. The U.S. 
Food and Nutrition Board states that an intake of 
2000 IU per day is the upper limit for safety. If you 
are concerned that you might be getting too much 

vitamin D, consult your doctor.  
 
If I use sunscreen, will it make 
me deficient in vitamin D? 
Proper sunscreen use and other 
sun protection practices may de-
crease vitamin D synthesis. How-
ever, there are proven benefits 

from protecting your skin against the harmful ef-
fects of UVB radiation. That is why the safest and 
recommended way to obtain adequate vitamin D 
is through a combination of diet and supplements. 
 
What are the best dietary sources of Vitamin 
D? 
Vitamin D exists naturally in some foods in small 
amounts and it can be difficult to get enough from 
diet alone. However, most dairy products and ce-
reals and some orange juice are now fortified with 
Vitamin D. Check food labels for Vitamin D con-
tent. For example, a cup of fortified milk has about 
120 IU of Vitamin D, whereas one three-ounce 
serving of sockeye salmon can contribute up to 
800 IU of Vitamin D. 
 
If I decide to take a supplement, should I take 
vitamin D3 or vitamin D2?  
Two forms of vitamin D are used in supple-
ments—D3 and D2. D3 is the preferred form as it 
is chemically similar to the form of vitamin D pro-
duced by the body and is more effective at raising 
the blood concentrations of vitamin D. 
 
To register for the program, contact Lizabeth Doty 
at the Senior Center at 203-834-6240. 

What About Vitamin D? 

 



Wilton Social Services provides counseling, informa-
tion, referral, and emergency financial assistance to 
Wilton residents who are experiencing financial diffi-
culties.  We encourage people to call our office to 
discuss our services.  Confidentiality is assured. 
  
State and federal programs designed to assist indi-
viduals and families during difficult economic times 
include fuel assistance, nutritional assistance and 
emergency financial assistance  
  

Heating Assistance 
  
The Connecticut Energy Assistance Program 
(CEAP) provides energy assistance grants for heat 
to households with income no greater than 60% of 
the State Median Income, e.g. individual, 
$31,712.72; couple, $41,470.48; and family of 4, 
$60,986..  Asset limits are $10,000 for homeowners 
and $7,000 for renters.  Retirement accounts are not 
counted as assets for those under the age of 59 ½.  
Apply through Wilton Social Services (203-834-
6238) or at NEON in Norwalk (203-663-7337).  Call 
for an appointment. 
  
Operation Fuel provides a one-time grant of $350 
to low-income households for deliverable fuel.  The 
program also assists with non-heat utility bills that 
are overdue.  Income must be under 60% of the 
State Median Income which for an individual is 
$31,712.72; couple, $41,470.48; and family of 4 
$60,986.  There is no asset test.  Apply through Wil-
ton Social Services (203-834-6238). 
  

Food Assistance 
  
SNAP is the Supplemental Nutritional Assistance 
Program provided through the Connecticut Depart-
ment of Social Services. For more information con-
tact Catherine Pierce at Wilton Social Services or 
visit www.ct.gov/dss and click on SNAP for more 
information and an application.  Applications should 
be mailed to Department of Social Services, 1642 
Bedford Street, Stamford, CT  06905. 
 
Angel Food Ministries is a non-profit, non-
denominational organization that provides food relief 
and financial support to communities  At a local Fair-

field County site, Wilton residents may purchase in-
expensive and healthful food.  One order provides a 
family of four with food for one week at a cost of 
$30.  There are  smaller options for seniors. Learn 
more at www.angelfoodministries.com. 
  
Wilton Social Services operates the Wilton Inter-
faith Food Pantry at the Comstock Community 
Center at 180 School Road.  Hours of operation are:   
 
 Monday 1:30 p.m. to 4:00 p.m. 
 Tuesday 9:00 a.m. to 12 noon 
 Wednesday 9:00 a.m. to 12 noon 
   2:30 p.m. to 5:30 p.m. 
 Thursday 9:00 a.m. to 12 noon 
 Friday  1:30 p.m. to 4:00 p.m. 
 
There are perishable and non-perishable food, per-
sonal care items, paper products, and detergents.  
Call Wilton Social Services at 203-834-6238. 
  

Health Insurance 
  
The state of Connecticut offers free and low-cost 
health insurance to individuals and families.  Learn 
about HUSKY and Charter Oak at www.ct.gov/dss.  
Click on the HUSKY and Charter Oak links.  Apply 
through Wilton Social Services or the website. 
  

Emergency Financial Assistance 
  
The Wilton Interfaith Fund and the Salvation 
Army provide emergency funds for Wilton residents 
in need.  They help pay for emergency oil deliveries, 
utility bills to prevent shut offs, rent, and other ex-
penses.  A financial application and a confidential 
appointment with Catherine Pierce, Director, Wilton 
Social Services are required.  Please call 203-834-
6238 to discuss these programs. 

Where to Find Help When Facing Economic Hardship 
Catherine Pierce, LCSW, Director, Wilton Social Services 

Phone:  203-834-6238        Fax:  203-563-0172 

Printing costs for this issue 

have been underwritten by 
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Book Discussion 
 

Book Discussion takes place at 
the Senior Center at 11:00 a.m. 
on the fourth Tuesday of the 
month.  Lunch ($3) is served at 
noon.  Call 203-834-6240 to re-
serve a place. 
 
Tuesday, March 22 
Discussion Leader – Kathy Leeds 
The Help by Kathryn Stockett 
Kathryn Stockett’s novel featuring three extraordi-
nary women creates an engrossing portrait of the 
rural South in the 1960’s.  The main character, 
Eugenia ―Skeeter‖ Phelan, has returned home to 
her parents’ cotton farm after graduating from Ole 
Miss.  Anxious to become a writer, she begins to 
collect the stories of the black women on whom the 
country club set depends.  At first these women are 
afraid to cooperate with her but in time two stalwart 
women, Aibileen and Minny, agree to tell their sto-
ries and are able to convince ten others to do the 
same.  The book Skeeter puts together shocks the 
white community but brings hope to the black com-
munity and gives her the courage to pursue her 
dreams. 
 
Tuesday, April 26 
Discussion Leader – Miwako Ogasawara 
The Comedians by Graham Greene 
Set in Haiti during the time of ―Papa Doc‖ Duvalier 
and the Tonton Macoute, this is a novel of adven-
ture and intrigue.  Both tragedy and comedy, it was 
written at a time of crisis in Greene’s personal life 
and the book reflects this in its setting in a country 
in crisis, a time of terror and stress.  Beginning with 
a voyage on a Haiti-bound cargo ship where the 
main characters named Brown, Smith, and Jones 
originally meet, the story reveals that no character 
is who he really seems to be.  Tragic and troubled, 
in a sense they are all comedians and at a certain 
point each is described as such.  Paul Theroux in 
his introduction to the paperback edition states:    
―Haiti had no fiction—and hardly had a face—until 
Greene wrote this book.‖ 
 
 

Please call the Wilton Library 203-762-3950 
in advance to reserve your copies! 
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PLAY READING 
 
Monday, March 7 
Moderator—Sherman Poultney 
Androcles and the Lion 
by George Bernard Shaw 
 
This play is a retelling of the consequences of the 
meeting of Androcles, a slave, and a wounded lion.    
Shaw’s tale of early Christianity stars an amiable 
chap who refuses to hunt or kill and who befriends 
animals to the degree that he is able to remove a 
thorn from a lion’s paw.  Enjoy this  cynical, humor-
ous, poignant, and hypocritical view of religion ver-
sus humanism. 

 
P.S.  The movie version of ―Androcles and 
the Lion‖ will play in the Senior Center 
lounge on Monday, March 14, at 12:30 p.m. 
 

 
Monday, April 4 
Moderator—Andrea Ragusa 
The Would-Be Gentleman by Moliere 
 
This seventeenth century comedy of manners, first 
published in 1671, takes place in Paris.  The central 
character is a tradesman who aspires to be a gen-
tleman.  He believes that superficial manners, ac-
complishments, and speech are necessary goals.  
To that end he engages a dancing master, a music 
master, a fencing master, a philosophy teacher, and 
other tutors who are as vain and ignorant as he is.  
They constantly quarrel among themselves as to 
which art is the most important. 

BROOKDALE PLACE 

On Saturday, March 19, from 2 to 4 p.m. Brookdale 
Place of Wilton at 96 Danbury Road will hold an 
open house.  The public is invited to visit the com-
munity and enjoy light refreshments. 

On Thursday, April 28, at noon Brookdale Place of 
Wilton will present a lunch-and-learn program.  Ana 
Nelson, Fairfield County’s Regional Director with the 
Alzheimer’s Association, will speak on ―What to 
Know about Memory Loss and Current Alzheimer’s 
Research.‖  Seating is limited.  Please call Christy 
Perone at 203-761-8999 to reserve space. 



 

BLOOD PRESSURE SCREENINGS 
Sponsored by Visiting Nurse & Hospice 

 

Wednesday, March 16 and April 20 
Wilton YMCA , 404 Danbury Road 

9:00-10:30 a.m. 
 

Tuesday, March 22 and April 26 
Village Market, 108 Old Ridgefield Road 

12:30-2:00 p.m. 
 

Thursday, March 3 and April 7 
Wilton Senior Center, 180 School Road 

11:00 a.m.-12 Noon 
 

Friday, March 4 and 18 and April 1 and 15 
Ogden House, 100 River Road 

9:30-11:00 a.m. 
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MOVE, STRENGTHEN, AND STRETCH 

Attention active seniors! Join this 
exciting, new fitness class on Fri-
day mornings from 10:30 a.m. to 
11:30 a.m. until the end of April. 
Location is the Senior Center. Each 
class combines light aerobic move-
ment for heart health with light 
weights for strength and gentle 
stretching to tone your body. Move 

at your own pace. Fee for this drop-in class is $3 
per class.  
 
Move, Strengthen, and Stretch is taught by Julienne 
Camhi, a Norwalk resident with ten years of experi-
ence and certifications as Health Fitness Specialist, 
Personal Trainer, and Group Exercise Instructor. 
She is a Certified Personal Trainer with Visiting 
Nurse & Hospice of Fairfield County and is a group 
fitness instructor at Tully Health Center, Norwalk 
Community College, and at the Edgehill Senior 
Residence in Stamford.  Call Lizabeth Doty at 203-
834-6240 for more information. ENHANCE FITNESS 

 

Through a grant from Enhance Fitness, Mary Ann 
Genuario, Health and Fitness Director at the Wilton 
Family Y, brings the Enhance Fitness program to 
the Senior Center.  The one-hour class includes 30 
minutes of endurance-type activity and specific 
strengthening exercises for legs, trunk, arms and 
shoulders. Enhance Fitness helps to maintain or 
enhance cardio-respiratory fitness, muscle strength, 
balance and flexibility. 
 

The class is taught by Denise Suarez and Leslie 
Hinshaw, instructors at the Wilton Y.  It takes place 
on Mondays, Tuesdays, and Thursdays from 9:00 
a.m. to 10:00 a.m.  Fee for this drop-in class is $3 
per class. 

SKETCHING AND PAINTING FOR ALL 
Discover the hidden talent you may have.  Viola 
Galetta will instruct beginners in the basics of draw-
ing still life, landscape, and even portrait.  Students 
will experiment with acrylics and water colors in a 
relaxed atmosphere.  No experience necessary.  
Please bring a sketchpad and soft pencil to the first 
class.  (Available at Walmart or art supplies stores.)  
Additional materials needed for future classes will 
be discussed during this class.  
 
Date:  March 18 and April 15 
Time:  10:30 a.m. to noon 
Fee:  $10 drop-in fee per class 

Julienne Camhi 

No one really chooses to age, but unfortunately it 
just comes with the passage of time.  As we age, it 
often becomes difficult or even painful to move, and 
we tend to slow down or sometimes even stop mov-
ing altogether.  If we stop moving, the body loses 
strength, and we feel even more stiffness and pain.  
It’s a vicious cycle.  To stay active and vibrant, it’s 
imperative to keep moving. 
 
Do you want to keep moving through dance?  Gail 
Shapiro leads the Line Dancing on Mondays at 

10:30 a.m. in the dance studio. 
 
Do you prefer a quieter exercise?  Denise O’Hearn 
conducts two Yoga sessions each week.  One takes 
place on Tuesdays at 11:00 a.m., and the other 
takes place at 10:00 on Thursdays.  Debbie Dong 
teaches Tai Chi on Wednesdays at 10:00.  Both Tai 
Chi and Yoga are a great way for seniors to tune 
into their bodies and to learn effective and gentle 
ways to keep moving and to heal.  Why not give it a 
try???? 

DON’T FORGET THESE “GOOD OLE” WEEKLY ACTIVITIES... 
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TAKING THE ―LOSS‖ 
OUT OF HEARING LOSS 

 
HLAA Southwestern CT Chapter Meeting 

Saturday, April 16, at United Covenant Church, 
68 Westport Rd (Rt 33), Wilton 

 
Don’t miss this special presentation about the im-
portance of addressing feelings of grief and loss 
associated with sudden or gradual hearing loss or 
other physical impairment. Participants will be en-
couraged to share their personal experiences and 
to join a guided, stress-reducing meditation ses-
sion presented by Nanette Greene and Kristin Car-
penter of Visiting Nurse & Hospice of Fairfield 
County. Nanette is a licensed professional coun-
selor with extensive training in mindfulness-based 
stress reduction from the University of Massachu-
setts Medical School. Kristin is a licensed clinical 
social worker currently providing individual and 
group grief and bereavement services to patients 
and their families.  Program is free and open to the 
public. For more information about the Hearing 
Loss Association of America Southwestern Con-
necticut Chapter, call Alan Gould, President, at 
203-834-9737 or visit http://hearez.org. 

CHOLESTEROL SCREENING 
DATE: Tuesday, April 12 
TIME:  8:30 a.m. to 11:30 a.m. 
 
LOCATION: Visiting Nurse & Hospice of Fairfield 
County, 761 Main Avenue, Suite 114, Norwalk 
(across from Walmart on Main Ave) 
 
COST: $25  includes total cholesterol, LDL, HDL, 
triglycerides & glucose, blood pressure, BMI cal-
culation and health counseling session with RN. 
By appointment only. Please call 203-762-8958.  

Seminar with Sonia 

To awaken the sleeping teacher 
inherent in all of us, learn the sim-
ple steps of self-hypnosis with 
Sonia Katz.  In a recent interview, 
Ms. Katz explained:  ―It is a skill 
that can be easily understood and 
implemented.  I have used this 
knowledge for over 40 years and want to share this 
with you.  Join me for a workshop of fun and relaxa-
tion whatever your age or experience.  This is a 
positive step to improving the quality of your life.  
After all, hypnosis is really focused concentration.‖ 
 
Ms. Katz studied hypnosis with Dr. Brian Weiss, 
author of Many Lives, Many Masters.  Ms. Katz will 
teach how to achieve relaxation through breathing 
techniques, guided meditation, and position, and 
how to plant the proper suggestions in the uncon-
scious mind in order to achieve goals. 
 
When:  Thursdays, April 14, 21, and 28 at 2:00 p.m. 
Where:  Senior Center 
Fee:  $5 per class 

 

CRIS RADIO 
Connecticut's Talking 

Newsstand for the Blind 
and Print-Handicapped 

 
CRIS Radio, a non-profit 
501©(3) is Connecticut’s only 
radio-reading service.  It 

broadcasts news and information for people with 
visual, physical, or learning disabilities that prevent 
them from reading printed material.  The free ser-
vice offers timely access to daily newspapers and 
more than 30 current magazines, 24 hours a day, 
seven days a week. 
 
CRIS Programs include: 

Front Pages News Hour—Top daily news fea-

tured in local, state, and national newspapers 

Regional Round-Up News Hour—Afternoon 

news updates featured in regional newspapers 

CRIS Sports—Sports news featured in state and 

national newspapers 

Market Time—Sale items featured in grocery 

and department store circulars 

Live and Times– Obituaries featured in local and 

state newspaper 

Approximately 80 percent of CRIS listeners are 50 
years and older.  Up to 50,000 people in Connecti-
cut are eligible to receive CRIS services.  Call 860-
527-8000 or email info@crisradio.org for more infor-
mation. 

http://hearez.org


MARCH 2011 
Monday Tuesday Wednesday Thursday Friday 

 1 
9:00  Enhance Fitness 
11:00  Yoga 
12:00  Garden Club Ac-
tivity and Lunch 
 

2 
9:30  RSVP 
10:00  Tai Chi 

10:00  Comstock Writ-
ers 

12:00  Lunch OH com-
pliments of the Wilton 
Police 
Program:  Chief Michael 
Lombardo 
12 Duplicate Bridge 

3 
9:00  Enhance Fitness 
10:00  Yoga 
11-12 Blood Pressure 
Screening 
12:00  Lunch 
12:45  Bingo 
 

4 
9:30-11 Blood Pressure 
OH 
10:00  Jewelry Workshop 
10:00  Movie, ―Razor’s 
Edge‖ 
10:30  Move, Strengthen, 
Stretch 
12:00  Bridge 
1:30-3  Free Senior Swim 
Y 
1:30 Beginner Bridge 

7 
9:00  Enhance Fitness 
10:30 Line Dancing 
11:30 Coffee and… 
12:30 Play Reading with 
Sherman 
 

8 
Philadelphia Flower 
Show 
9:00  Enhance Fitness 
11:00  Yoga 
1:00 Comstock Knitters 
and Crafters 

 

9 
9:30  RSVP 
10 Tai Chi 

12:00  Lunch OH 
Program:  Jerry King 
Music 
 

10 
9:00  Enhance Fitness 
10:00  Yoga 
12:00  Lunch 
12:45  Bingo 
 
5:30 Social Service 
Commission 

11 
10:30  Move, Strengthen, 
Stretch 
12  Bridge 
1:30-3  Free Senior Swim 
Y 
1:30 Beginner Bridge 

14 
9:00  Enhance Fitness 
9-12 AARP Tax Help 
10:30 Line Dancing 
11:30 Coffee and… 
12:30  Movie, ―Androcles 
and the Lion‖ 
 

15 
8:45  Watercolor Art OH 
9:00  Enhance Fitness 
11:00  Yoga 
12  Duplicate Bridge 
 

16 
9-10:30 Blood Pressure 
Screening Y 
9:30  RSVP 
10:00  Tai Chi 

10:00 Comstock Writers 

12:00  Lunch OH 
Program:  Dayle Fried-
man 
 

17 
9:00  Enhance Fitness 
10:00  Yoga 
12:00  Lunch 
12:45  Bingo 
 

18 
9:30-11 Blood Pressure 
Screening OH 
10:30  Move, Strengthen, 
Stretch 
10:30  Painting with Viola 
12:00  Bridge 
1:30  Beginner Bridge 
1:30-3  Free Senior Swim 
Y 

21 
9:00  Enhance Fitness 
10:30  Line Dancing 
11:30 Coffee and… 
 

22 
8:45 Watercolor Art OH 
9:00  Enhance Fitness 
9:30 Intro to Computer 
11:00  Yoga 
11 Book Discussion with 
Kathy Leeds 
12:00  Lunch 
12:30-2 Blood Pressure, 
VM 
 

23 
9:30 RSVP 
10:00  Tai Chi 

12:00  Lunch OH 
Program:  Get Rid of 
your Stuff Bingo 
 

24 
9:00  Enhance Fitness 
10:00  Yoga 
12:00  Lunch 
12:45  Bingo 
 

25 
9:30 Intro to Computer 
10:30  Move, Strengthen, 
Stretch 
12:00  Bridge 
1:30 Beginner Bridge 
1:30-3  Free Senior Swim 
Y 

28 

9:00  Enhance Fitness 
10:30  Line Dancing 
11:30 Coffee and… 
12:15 Forever Fit Y 
1:00 Comstock Knitters 
and Crafters 

29 

8:45 Watercolor Art OH 
9:00  Enhance Fitness 
9:30  Beyond Beginners-
Word 2007 
11:00  Yoga 
 

30 
9:30 RSVP 
10 Tai Chi 

12:00  Lunch OH 
Program:  ―Echoes of 
Sinatra‖ sponsored by 
Laurel Ridge Health 
Care 
 

31 
9:00  Enhance Fitness 
9:30  Beyond Begin-
ners– Word 2007 
10:00  Yoga 
12:00  Lunch 
12:45  Bingo 
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APRIL 2011 
Monday Tuesday Wednesday Thursday Friday 

1 
9:30-11 Blood Pressure 
Screening OH 
10:00  Jewelry Workshop 
10:30  Move, Strengthen, 
Stretch 
12:00  Bridge 
1:30 Beginner Bridge 

 

4 
9:00  Enhance Fit-
ness 
10:30 Line Dancing 
11:30 Coffee and… 
12:30 Play Reading 
with Andrea 
 

5 
8:45  Watercolor Art 
OH 
9:00  Enhance Fitness 
9:30  Word Graphics 
11:00  Yoga 
12:00  Garden Club 
 

6 
9:30  RSVP 
10:00  Comstock Writers 
10:00  Tai Chi 
12:00  Lunch OH 
Program:  Wilton Volunteer 
Ambulance Corps 
12 Duplicate Bridge 

7 
9:00  Enhance Fitness 
9:30  Word Graphics 
10:00  Yoga   
11-12 Blood Pressure 
Screening at the Senior 
Center 
12:00 Lunch 
12:45  Bingo 

8 
8:15-12:30 55 ALIVE! 
10:00  Jewelry Workshop 
10:30  Move, Strengthen, 
Stretch 
12:00  Bridge 
1:30  Beginner Bridge 
1:30-3  Wilton Family Y 
Free Swim for Seniors 

11 
9:00  Enhance Fit-
ness 
10:30 Line Dancing 
11:30 Coffee and… 
 

12 
8:30-11:30 Cholesterol 
Screening VNH 
8:45  Watercolor Art 
OH 
9:00  Enhance Fitness 
9:30  Advanced 
Graphics 
11:00  Yoga 
1:00  Comstock Knit-
ters and Crafters 

13 
9:30 RSVP 
10 Tai Chi 
12:00  Lunch at OH 
Program:  WWC Bingo 
 

14 
9:00  Enhance Fitness 
9:30  Advanced Graphics 
10:00  Yoga 
12:00 Lunch 
12:45  Bingo 
2:00  Seminar with Sonia 
5:30 Commission on So-
cial Services 

15 
9:30-11  Blood Pressure 
OH 
10:30  Sketching and 
Painting with Viola 
There’s no Move, Strengthen, and 
Stretch today. 

12:00  Bridge 
1:30  Beginner Bridge 
1:30-3  Wilton Family Y 
Free Swim for Seniors 

18 
9:00  Enhance Fit-
ness 
9:30  Textboxes 
10:30 Line Dancing 
11:30 Coffee and... 
 

19 
8:45  Watercolor Art 
OH 
9:00  Enhance Fitness 
9:30 Word Art 2007 
11  Yoga 
12 Duplicate Bridge 
 

20  
9-10:30 Blood Pressure Y 
9:30 RSVP 
10 Comstock Writers 
10 Tai Chi 
12  Lunch at OH 
Program:  ITN Transportation 
Service 

21 
9:00  Enhance Fitness 
9:30  Organize your Bio-
graphical Material 
10:00  Yoga 
11:45 Wilton Senior 
Council Meeting at Brook-
dale 
2:00  Seminar with Sonia 

22 
9:30 Personalize your 
Word Program 
10:30  Move, Strengthen, 
Stretch 
12:00  Bridge 
1:30 Beginner Bridge 
1:30-3  Wilton Family Y 
Free Swim for Seniors 
 

25 
Mohegan Sun Ca-
sino Trip 
9:00  Enhance Fit-
ness 
10:30 Line Dancing 
11:30 Coffee and... 
1:00  Comstock 
Knitters 

26  
8:45  Watercolor Art 
OH 
9:00  Enhance Fitness 
11  Yoga 
11 Book Discussion 
with Miwako Ogasa-
wara 
12:00 Lunch 
12:30-2 Blood Pres-
sure at Village Market 

27 
9:30   
9:30 RSVP 
10 Tai Chi 
12:00  Lunch OH 
Program:  Vitamin D with 
Elaine Abrams 

28 
―Singing in the Rain‖ Trip 
OH 
9:00  Enhance Fitness 
10:00  Yoga 
12:00  Memory Loss 
Presentation B 
12:00 Lunch 
12:45  Bingo 
2:00  Seminar with Sonia 

29 
10:30  Move, Strengthen, 
Stretch 
12:00  Bridge 
1:30 Beginner Bridge 
1:30-3  Wilton Family Y 
Free Swim for Seniors 
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OH Ogden House  100 River Road  203-762-8035 
Y Wilton Family Y  404 Danbury Road 203-762-8384 
WL Wilton Library  137 Old Ridgefield Rd. 203-762-3950 
G The Greens   435 Danbury Road 203-761-1191 
WM Wilton Meadows 439 Danbury Road 203-834-0199 
VM Village Market  Old Ridgefield Road 203-762-7283 
NHC Nursing & Home Care 761 Main Ave. at 203-762-8958 
B Brookdale  96 Danbury Road 203-761-8999 
LR Laurel Ridge  642 Danbury Rd.  203-438-8226 



COMSTOCK KNITTERS AND CRAFTERS 
 

Join the Comstock Knitters and Crafters!  The group 
meets on the second Tuesday and fourth Monday 
of each month at 1:00 p.m. at the Senior Center— 
so that’s March 8 and 28 and April 12 and 25.  This 
is an opportunity to get together 
with others who enjoy crafting.  
Any handiwork is welcome; 
come and spend an hour or two 
with people who enjoy these 
crafts.  Join us on either Tues-
day or Monday, or both!  The 
coffee’s always on!  Call Liza-
beth Doty for more information 
at 203-834-6240. 

55 ALIVE! DRIVING COURSE 
 

Friday, April 8 
8:15 a.m.-12:30 p.m. 

Comstock Community Center 
 

This is an adult driving education 
course for skill improvement.  A trained 
facilitator will help you adjust your driv-
ing to age-related changes.  You may 
save money on auto insurance if you 
are 62 or older and complete the course.  Partici-
pants must be at least 50 years old and have a valid 
Connecticut drivers license.  Class limited to 30.  
Fee:  $12 for AARP members; $14 for non-
members.  Register at the Parks and Rec Depart-
ment office in Comstock or call 203-834-6234. 
 
AARP also makes the 55-ALIVE! Driver Safety Pro-
g r a m  a v a i l a b l e  o n l i n e .   C h e c k 
www.aarpdriversafety.org for details. 
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Senior Center Update 
 
On Valentine’s Day, ten women from Realty Seven 
devoted their energy and decorating talent to Senior 
Center renovations and improvements.   These la-
dies spent the day transforming the former Senior 
Center space into an inviting room for seniors to eat 
a meal, have a cup of coffee, or just chat.  The walls 
display vintage pictures of Wilton residents and pe-
riod artifacts.  Meeting Room 21 was similarly trans-
formed into a comfortable, stylish lounge where sen-
iors may watch a show on the large flat screen TV, 
read a book, or play a round of cards at one of the 
new tables.  Meeting room 24 was transformed into 
the game room where cards and billiards may be 
played.  The room is appointed with different game 
motif wall decorations. 
Our heartfelt thanks go to Tracy Armstrong, Sharon 
Brameier, Pam Cole, Debbie Estes, Lynne Murphy, 
Jane Sementini, Dori Seamans, Karin Venditti, Katy 
Williams, and owner Peg Koellmer.  Thanks to 
Judee Beardsley of Beardsley Fine Framing for the 
café centerpieces and to Rick Koellmer, Arthur 
Wienslaw and Marc DeSimone for their donation of 
time and carpentry skills.  They did a splendid job 
and the seniors are already enjoying the improved 
facility.  We could never thank them enough for their 
generous donation of time and talent… 
 
But wait…. there are  more changes in the works, 
and First Selectman Bill Brennan looks forward to 
holding a press conference when all the improve-
ments have been completed. 

Wilton Commons Update 
 
This past November the Town voted to extend 
Wilton Commons’ option to lease until December 
8, 2011.  Since that time, the WCI Board has 
been working on the following priorities: 
 

Preparation of construction and other needed 
documents for the bidding and award 
process in March; 

Submission of plans, specifications and final 
construction budget to the Town in March; 
and 

Submission of final budgets to the Connecti-
cut Housing and Finance Authority and 
the Department of Economic and Com-
munity Development in April. 

 
About three years ago due to the downturn in the 
economy we stopped our fundraising campaign.  
Our goal was $2 million in pledges and dona-
tions.  Since that time we have incurred over 
$300,000 in expenses.  Hopefully, you can help 
us by making a donation to Wilton Commons, 
Post Office Box 7505, Wilton, CT  06897.  All 
contributions are tax deductible.  As in the past, I 
know that we can count on you. 
 

George Ciaccio 
Chairman, Wilton Commons 

 



Michael Lombardo was ap-
pointed Chief of the Wilton Po-
lice Department. 
 
Chief Lombardo holds a Bache-
lor’s Degree in Criminal Justice 
from Sacred Heart University 
and a Master’s Degree in Criminal Justice from Bos-
ton University.  In addition, the Chief attended the 
FBI Law Enforcement Executive Development pro-
gram and participated in official training and certifi-
cation programs relating to law enforcement.  He 
also attended the Roger Williams University Crimi-
nal Justice Program for executive development. 
 
Chief Lombardo comes from a family with a 60-year 
legacy of police service, including his brother Robert 
who is presently with the Greenwich Police Depart-
ment.  Chief Lombardo resides in Trumbull with his 
wife Cathy and two children, Dana and Michael. 

Stay at Home in Wilton is a new 
organization that helps seniors 
remain in the homes they love.  
More specifically, Stay at Home 
provides transportation to doc-
tors, shopping, local errands, 
cultural events, and social activi-
ties; help with simple home 
maintenance tasks such as 
changing light bulbs and solving 
those irritating computer prob-
lems.  When tasks are more 
complicated, we provide the 
names of vendors that we have checked out. These 
vendor services will not be free but many vendors 
will give a discount on the work they perform.  We 
also have regular social events for members where 
you can enjoy getting together with your peers. 

 
Membership in Stay at Home in Wilton costs $360 
per year (less than a dollar a day).  For two folks in 
a home, the cost is only $480 for both.  If that cost is  
difficult for you, a generous donor has agreed to un-
derwrite scholarships that will cover over 80% of the  
member's cost. 

To sign up for membership, 
please check our website 
www.stayathomeinwilton.org for 
the membership form or call 
203-423-3225.  To apply for the 
reduced cost scholarship please 
contact Wilton Social Services 
who will verify your eligibility 
and give you a scholarship ap-
plication.  The identity of schol-
arship recipients recommended 
by Wilton Social Services will be 
known only to the Treasurer of 

Stay at Home in Wilton. 
 
On our web site, there is an opportunity to volunteer 
to help.  Just download the volunteer application 
form, fill it out and send it to our P.O. box.  Thanks. 
 
 
Phil Richards 
President, Stay at Home in Wilton, Inc. 
P.O. Box 46, Wilton, CT 06897 
203-423-3225 

Wilton Police Chief Michael Lombardo will address 
the seniors gathered at the Wednesday luncheon at 
Ogden House on March 2 at 12:45 p.m.  Our Police 
Chief will also answer questions from the audience. 
 
Michael Lombardo began his career as a patrolman 
with the Wilton Police Department in 1981.  He was 
assigned to specialized tasks as Field Training Offi-
cer, member of the SCUBA Dive Team, and on 
many occasions as an acting sergeant. 
 
In 1993, Officer Lombardo was promoted to Detec-
tive and served as the department’s crime preven-
tion officer for several years.  In 1998, he was pro-
moted to the position of Lieutenant.  In this role, he 
served as the Commander of the Detective Bureau 
until 2002 when he was transferred to the Patrol Di-
vision as one of its commanders.  In 2003, Lieuten-
ant Lombardo became the department’s Training 
Officer and in 2004, he was once again assigned to 
head the Detective Bureau.  On October 15, 2009, 

Police Chief Michael Lombardo 
will address seniors at luncheon 
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Chief Michael 

Lombardo 

http://www.stayathomeinwilton.org/
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The mission of the Senior Center is to provide 

Wilton’s older citizens with stimulating and 

creative opportunities for their social, physical, 

emotional, and intellectual enrichment. 

COMSTOCK COMPUTER LEARNING CENTER 

180 School Road, Wilton, CT  06897 

 

Name:  __________________________________________________________ 

Address: __________________________________________________________ 

Phone:  __________________________________________________________ 

E-Mail:  _________________________________________________________ 

Mail this completed form along with your  check payable to TOWN OF WILTON. 

X COURSE TITLE DATES FEE 

 Introduction to Computer Fundamentals March 22 and 25 $25 

 Beyond Beginners —Word 2007 March 29 and 31 $25 

 Introduction to Word 2007 April 5 and 7 $25 

 Word 2007 Graphics March 22 and 24 $25 

 Advanced Graphics in Word 2007 April 12 and 14 $25 

 Quick Pick:  Working with Text Boxes April 18 $10 

 Quick Pick:  Word Art in Word 2007 April 19 $10 

 Quick Pick:  How to organize your materials for a 
Biography or Memoire you are writing 

April 21 $10 

 Quick Pick:  Personalize Your Word 2007 Program April 22 $10 

For additional information on the courses listed above, call  203-834-6410 or 203-762-8445, 

or visit www.wiltonct.org and click on the ―Corridors‖ newsletter, page 13. 

Lifetime Learners Institute, a non-profit educational 
organization for people over 50 at Norwalk Commu-
nity College, announces its Spring Semester day-
time classes, beginning the week of March 20.  Life-
time Learners will be offering nearly 50 non-credit, 2-
hour courses.  These take place in the afternoon at 
either 1:00 p.m. or 3:00 p.m.  Topics include history, 
music, current events, movies, photography, lan-
guages, religions, arts, books, theater, opera, travel, 
and memoirs.  Register early.  Member course fees 
are only $20 for each course, and memberships are 
still available for $30.  A membership card also enti-
tles you to use the NCC Fitness Center as well as to 

attend the ―Lunch and Learn‖ guest presentations 
which take place on Fridays at 1:00 p.m.  For addi-
tional information phone anytime 203-857-3330 to 
leave a message or visit www.lifetimelearners.org  

Fifty is Nifty at Lifetime Learners Institute 

http://www.lifetimelearners.org
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ElderHouse Serving our Community 
for Thirty-Two Years. 

ElderHouse is a private not-for-profit adult day 
center located in Norwalk.  After 32 years it is 
still going strong and providing daily care for 
seniors.  

The center provides door-to-door van trans-
portation in five towns including Wilton.  A 
nurse tends to daily medical issues while the 
seniors enjoy a wide range of therapeutic rec-
reation programs. A home-style meal is 
served at noon and help with grooming and 
showering is also available.  The center is 
open six days a week. 

An assessment by our social worker and a 
visit day are available free of charge. Please 
contact Sally Harding, MSW at 203-847-1998 
for more information.  

OGDEN HOUSE 
 
Lightweight Chair Exercise Class returns to Ogden 
House on Thursdays March 10 and 24 from 2:15 
p.m. to 3:15 p.m. in the living room. 
Betty will be teaching using Poland Spring water 
bottles working the upper and lower body. 
She will be focusing on breathing with slow repeti-
tive movements. 
Please call the office to sign-up as dates will vary 
monthly. 
The class is free. 
  
Sandra Bacher teaches Watercolor Art on six Tues-
days beginning March 15 from 8:45 a.m. to 11:45 
a.m.  The subject will be winter landscapes. 
Six classes: $20 for Ogden House residents; $27 for 
non-residents. 
  
On Thursday, March 31, we will take a trip to the 
Botanical Gardens for THE ORCHID SHOW: ON 
BROADWAY.  Orchids and the theatre are melded 
by Tony award-winning set designer Scott Pask and 
image maker Drew Hodges.  The cost is $7.50 for 
Ogden House residents and $15 for non-residents.  
Lunch is on your own.  We will leave Ogden House 
at 10:00 a.m. and return by 3:30 p.m.  Call 203-762-
8035 to sign-up.  

WILTON TAX RELIEF PROGRAM 
FOR ELDERLY OR DISABLED 

HOMEOWNERS 
APPLICATION DEADLINE:  FRIDAY, MAY 13 

 
YOU MAY RECEIVE BENEFITS UNDER WILTON’S 

TAX RELIEF PROGRAM FOR ELDERLY OR DISABLED 
HOMEOWNERS IF... 

  

  You were at least 65 years of age or over as of 
December 31, 2010, or your spouse was; or you 
were at least 60 years of age as of December 
31, 2010, and you are the surviving spouse of a 
taxpayer who qualified for tax relief at the time of 
his/her death; or 

  

  You are under 65 years of age and permanently 
totally disabled under Social Security Disability; 
and 

  

  You have been a Wilton taxpayer for at least one 
year; and 

  

  You have occupied your Wilton property as your 
principal residence for more than 183 days dur-
ing the past twelve months; and 

  

  Your qualifying household income for 2010 is 
$75,000 or less. 

 
YOU MAY BE ENTITLED TO A REDUCTION IN YOUR 
REAL ESTATE TAX AND YOU MAY BE ABLE TO 
POSTPONE PAYMENT OF A PERCENTAGE OF THE 
TAX BALANCE. 

 

Your tax credit and tax deferral benefits will affect the real 
estate tax bill payable July 2011 and January 2012.  
Town of Wilton and State of Connecticut Tax Relief appli-
cations are available at the Town Hall Assessor’s office.  
The filing period for both programs is February 1 to May 
13.  For more information, contact the Wilton Assessor’s 
office at 203-563-0121. 

 

Free Tax Help Available 
at the Senior Center 

 
The AARP program provides income tax prepara-
tion assistance for low and middle-income taxpay-
ers of all ages, with special attention to those 60 
and older.  Volunteers from AARP will be at the 
Senior Center on Monday, March 14, from 9:00 
a.m. until noon to assist in tax preparation.  No ap-
pointment is necessary.  
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GUIDE TO SENIOR SERVICES 
 

Catherine Pierce ................................. 203-834-6238 
Director, Social Services/Municipal Agent for the Elderly 
 

Lauren Hughes ................................... 203-834-6238 
Coordinator, Senior Services 
 

Lizabeth Doty ..................................... 203-834-6240 
Coordinator, Senior Activities 
 

Andrea Ragusa ....... 203-762-8445 or 203-834-6410 
Comstock Computer Learning Center 
 

Sharon Powers.................................... 203-834-6238 
Office Assistant 

 

Meals-on-Wheels ................................ 203-762-0566 

Dial-A-Ride ......................................... 203-834-6235 

Town-to-Town .................................... 203-299-5180 

FISH (medical appt. transportation) 203-834-3737 

AARP .................................................. 203-866-0435 

RUOK (Are You OK?) . 203-834-6238 or 834-6260 

Mid-Fairfield Hospice ........................ 203-762-8958 

Visiting Nurse & Hospice .................. 203-762-8958 

Parks and Rec Department ............... 203-834-6234 

Tuesday, March 8 

Philadelphia Flower Show 
This year’s theme is ―Springtime in Paris‖!  

Enjoy this incredible Flower Show, or 
spend the day strolling through the historic 

sites of the city. 
Depart: 7:00 a.m.; Return: 7:00 p.m. 

Resident Fee: $25.00; Non-Resident: $35.00 
(Transportation Only) 

 
Monday, April 25 

Mohegan Sun Casino 
Test you luck with over 4,000 slot machines 

and table games.  Browse through the 
many shops and stop by one of the eateries 

for lunch. 
Depart:  8:45 a.m.; Return:  5:00 p.m. 

Resident Fee: $25.00; Non-Resident: $35.00 
(Transportation Only) 

 

Call 203-834-6234 or visit 
www.wiltonparksandrec.org 



Do you already know how to use 

your computer?  Then these are for 

you! 

Beyond Beginners—Word 2007 

This course will help you get ready for the Intro to Word 2007.   

 

Introduction to Word 2007 

Step into the present to acquaint yourself with the Word 2007 program.  It has 

a different appearance from the Word version you may have been using.  The 

familiar toolbars and menus from previous versions of Word are gone!  This 

course will explore the Word Window, Office Button, Terminology, Ribbon 

Organization, Quick Access Toolbar, Document views, plus commonly used 

features in Word.  You will learn how to do the same things you’ve always 

done such as entering, changing, deleting, copying, pasting, underlining, 

aligning, saving, as well as inserting a bullet or number in text in a Word 2007 

environment.  (Guide and practice sheets included.) 

 

Word 2007 Graphics 

You will be amazed at what you can create!  A quick review will cover the 

Office Button, Terminology, Ribbon Organization, Office Clipboard, Quick 

Access Toolbar, and Mini Toolbar. From the Page Layout tab, you will 

apply borders to pages, paragraphs and text, and apply shading with cus-

tom color selections.  From the Home tab you will insert graphic styles of 

bullets and numbering; from the Insert tab, utilize task panes, galleries 

and/or contextual tool tabs for Clipart, Pictures, Positioning of Pictures, 

Word Art, Symbols, Special Characters, and text boxes.   (Guide and 

practice sheets included.) 

 

Advanced Graphics in Word 2007 

This course will build on the material learned in Word 2007 Graphics.  

You will further enhance your subject matter in a document, simple 

table or columns.  The Drawing function, with its many new features, 

will be covered in depth.  You will move through the Layout Tab for 

margins and orientation, Home Tab for specific functions to insert 

text material, and the Insert Tab to incorporate Word Art, Clip Art, 

Pictures, and Drawings.  (Guide and practice sheets included.) 

 

Basic Excel 

This course will introduce the basics of this popular spreadsheet program in-

cluding essential vocabulary, concepts and features.  Become familiar with 

entering, editing, and formatting numerical and text data.  Experiment with 

basic database capabilities.  Learn to design meaningful, attractive and useful 

spreadsheets. (Worksheets included.) 

Each two-session 
computer class is 

$25 and takes place 

from 

9:30 a.m.-11:30 a.m. 

 

 

The Computer Learning 

Center offers computer 

classes specifically designed 

for adults.  Come and experi-

ence computer learning in a 

stimulating and comfortable 

e nv i ro n -
Want to delve a little deeper?  Try a Quick Pick! Each single-session Quick Pick class takes 

place from 9:30 a.m. to 11:00 a.m.  The fee is 
$10 per class. 
 
Working with Text Boxes in Word 2007 
Learn and practice some of the little known func-
tions text boxes have to offer. 
 
Word Art in Word 2007 Explore creative options for using Word Art in a 
poster, document and a cover page.  

Bio Info 
Learn how to organize your materials for a biogra-
phy or memoire. 
 

Personalize your Word-2007 Program Learn how to set ―Word Options‖ for your defaults 
until you want a change.  Also learn how to set up 
taskbar and Quick Access Toolbar.  

Just beginning to use a computer?  This is for you! 

Introduction to Computer Fundamentals 

This introductory course is for those with limited or no computer experience who would like to 
test the waters.  It will include turning the computer on and off, using the mouse and keyboard, 
understanding the meaning of simple computer terms, opening and closing a program, and us-
ing the desktop.  This is excellent preparation for Introduction to Word 2007. 

Call Andrea at 203-762-8445 or 203-834-6410 to 

COMSTOCK COMPUTER 
LEARNING CENTER 

 

180 School Road, Wilton, CT  06897 

Andrea Ragusa, Coordinator 
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